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ABSTRACT
Fluid Flow Characterization and In Silico Validation in a Rapid Prototyped Abdominal
Aortic Aneurysm Model
Dean Thomas Wampler

Aortic aneurysms are the 14th leading cause of death in the United States. Annually,
abdominal aortic aneurysm (AAA) ruptures are responsible for 4500 deaths. There are
another 45,000 repair procedures performed to prevent rupture, and of these
approximately 1400 lead to deaths. With proper detection, the aneurysm may be treated
using endovascular aneurysm repair (EVAR). Understanding how the flow of the blood
within the artery is affected by the aneurysm is important in determining the growth of
the aneurysm, as well as how to properly treat the aneurysm. The goal of this project was
to develop a physical construct of the AAA, and use this construct to validate a
computational model of the same aneurysm through flow visualization. The hypothesis
was that the fluid velocities within the physical construct would accurately mimic the
fluid velocities used in the computational model. The physical model was created from a
CT scan of an AAA using 3D printing and polymer casting. The result was a translucent
box containing a region in the shape of the aneurysm. Fluid was pumped through the
construct to visualize and quantify the velocity of the fluid within the aneurysm.
COMSOL Multiphysics® was used to create a computational model of the same
aneurysm, as well as obtain velocity measurements to statistically compare to those from
the physical construct. There was no significant difference between the velocity values
for the physical construct and the COMSOL Multiphysics® model, confirming the
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hypothesis. This study used a CT scan to create an anatomically accurate model of an
AAA that was used to validate a computational model using a novel technique of flow
visualization. As EVAR technologies continue to progress, it will become increasingly
important to understand how the blood flow within the aneurysm affects the growth and
treatment of AAAs.

Keywords: Abdominal aortic aneurysm, computational validation, COMSOL
Multiphysics®, 3D printing, PDMS mold
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CHAPTER 1: INTRODUCTION

1.1.

Purpose and Background

Blood flow is an important field of study, both under normal physiological conditions and
diseased conditions. The leading cause of death in developed countries relates to
cardiovascular disease, of which the majority are related to abnormal blood flow in the
arteries [1]. An aneurysm occurs when a part of the wall of an artery weakens, allowing
the artery to balloon out. Aortic aneurysms are the 14th leading cause of death in the
United States. Annually, AAA ruptures are responsible for 4500 deaths2. There are
another 45,000 repair procedures performed to prevent rupture, and of these
approximately 1400 lead to deaths [2]. Abdominal aortic aneurysm ruptures have been
shown to affect 1 in 250 individuals over the age of 50. Men are four times more likely
than women to have a ruptured AAA. Five-year survival rate is only 19%, and the overall
mortality rate following the rupture of the AAA is over 90% [3]. 80-90% of all ruptured
aneurysm result in death, however, these deaths may be avoided with proper detection of
the aneurysm before it ruptures [4].

With proper detection, the aneurysm may be treated using endovascular aneurysm repair
(EVAR). For this procedure, an incision is made in the patient’s groin, and a guide wire
with an expandable stent graft is passed up the iliac artery to the location of the
aneurysm. Once the graft is positioned correctly, the stent graft is expanded within the
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artery. The stent graft pushes against the healthy portion of the artery, and guides the
blood through the graft, not allowing it to enter the aneurysm [5].

Understanding how the flow of the blood within the artery is affected by the aneurysm is
important in determining the growth of the aneurysm, as well as how to properly treat the
aneurysm. The goal of this project is to develop a physical construct of the AAA, and use
this construct to validate a computational model of the same aneurysm through flow
visualization. As EVAR technologies continue to progress, it will become increasingly
important to understand how the blood flow within the aneurysm affects the growth and
treatment of AAAs.

1.2.

Study Aims

Through developing this project, this thesis sought to establish a protocol for three key
ideas:

1. Create vasculature with an aneurysm in translucent polymer for flow visualization
2. Make the construct fully three dimensional with no seams
3. Perform flow visualization and velocity characterization for comparison with
finite element analysis

The goal of this project was to use a three-dimensional physical model of an AAA to
validate a COMSOL Multiphysics® computational model of the blood flow in the
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aneurysm. A three-dimensional model was made to simulate the aneurysm. In this model
the velocity of the fluid flow was examined, and was compared to COMSOL
Multiphysics® models of the same dimensions and characteristics as the physical model.
Success of this project was determined by the ability for the COMSOL Multiphysics®
model to reproduce the fluid flow in the physical model.
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CHAPTER 2: BACKGROUND AND RELATED STUDIES

2.1.

Needs for Model and Experiments

The purpose for examining and characterizing the shear stress profiles and velocity
profiles of an AAA construct was to validate the predicted profiles described by a
COMSOL Multiphysics® model. Knowledge of the shear stress and velocity profiles of
the aneurysm would allow for more accurate treatment of the aneurysm. A 3D model
could be of great use for testing medical devices such as stent grafts. With COMSOL
Multiphysics® validation, the 3D model could be used to examine how implants affect
the shear stress and velocity profile of the blood flow.

There have been a number of studies performed to investigate AAAs and the role that
shear stress and coagulation have on their rupture. One group performed flow
visualization studies for steady flow using in-vitro spherical models of aneurysms. They
determined the streamline patterns inside the bulge of the models, as well as that a jet of
fluid formed inside the aneurysm, surrounded by a region of recirculating fluid [6].
Stehbens et al observed boundary layer separation and reattachment using flow
visualization experiments in glass aneurysm models [7]. Drexler and Hoffman improved
on experimental models, using asymmetric casting resin models of aneurysms to observe
regions of stagnant or reversed flow [8]. Budwig et al examined numerical and
experimental studies of steady flow to demonstrate the effect of flow patterns in the
pressure distribution and shear stress distribution at the vessel walls [9]. Taylor and
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Yamaguchi demonstrated the existence of two symmetric vortices in three-dimensional
computational models using steady flow numerical simulations [10]. Peattie et al
observed that the maximum wall pressure inside the aneurysm is located at the center,
and that turbulence increases wall shear stresses at the distal end of the bulge [11, 12, 13].
A group proved the existence of monotonic increase of platelet aggregation at the
aneurysm wall, reaching a maximum at the distal edge, using a correlation between
steady blood flow dynamics and rates of platelet deposition [14, 15].

Studies done by Greinke [16], Willis [17], and Knauer [18] attempted to develop a flow
visualization model for vasculature. Greinke and Willis modeled the blood flow in an
iliac aneurysm, and Knauer modeled the blood flow in the aortic arch. All three studies
were successful in using the aneurysm construct to validate a COMSOL Multiphysics®
finite element analysis model. I have taken this previous work and expanded on the idea
of using a 3D AAA model to predict flow in-vivo. Using a CT scan of a patient provides
realistic geometries for the aneurysm, and through comparison between the PDMS model
and the COMSOL Multiphysics® model, I am able to predict shear stresses and flow
velocities. The aspects of my thesis that are novel are that I am taking a publicly available
CT scan of the AAA and creating a physiologically accurate aneurysm model. The
manufacturing of the PDMS construct is unique, in that there were no seams, and the
model was a single, solid construct.

5

2.2.

Anatomy & Physiology

2.2.1. Vessel Anatomy
Blood leaves the heart through the pulmonary valve, and travels through the aorta. It then
flows through the ascending aorta, aortic arch, descending aorta, and into the abdominal

http://my.clevelandclinic.org/

Figure 1. Anatomy of the aorta from the aortic root to the common iliac artery

aorta, from which it splits into the iliac arteries. This anatomy is shown in Figure 1.
The aorta is composed of three tissue layers, the intima, the media, and the adventitia, as

Figure 2. Anatomy of a vessel. Tunica externa (adventitia), tunica media, and tunica intima
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shown in Figure 2. The intima is the endothelial layer. The media consists of smooth
muscle cells surrounded by elastin, collagen, and proteoglycans. The elastin is the
principal load-bearing element of the aorta. The media is responsible for the structural
and elastic properties of the artery. The adventitia is composed primarily of collagen, but
also adrenergic nerves and a variety of cells, including fibroblasts and
immunomodulatory cells. The endothelial cells on the intima contact blood flow, while
the media and adventitia provide mechanical support opposing blood pressure. Tension
and deformation in the endothelium opposes the frictional force of the blood (wall shear
stress) on the endothelial layer. Circumferential stretch is opposed by circumferential
stress and strain in the vessel wall. These forces trigger biochemical reactions that
maintain the function of the blood vessels. The cells and fibers can remodel under
irregular conditions, such as hypertension. Changes in the chemical signaling can alter
the stiffness of the vessel, and change the strain or stress response [19]. Weakening of the
artery wall can be a factor leading to the progression of an aneurysm.

2.2.2. Physiology of the Aneurysm
In an aortic aneurysm, an increase in the concentration of proteolytic enzymes compared
to the concentration of their inhibitors, is thought to degrade the aortic media, particularly
as the individual ages. A group investigated the role of metalloproteinases in AAA
progression, as studies have shown that patients with AAAs have increased expression
and activity of matrix metalloproteinases (MMPs) [20]. MMPs and other proteases are
secreted into the extracellular matrix of AAA by macrophages and aortic smooth muscle
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cells (SMCs). MMPs and their inhibitors are responsible for vessel-wall remodeling, and
are located in normal aortic tissue. During the development of an aneurysm, the tissue
contains increased MMP activity, while the activity of its inhibitors is decreased. This
leads to the degradation of elastin and collagen, which are the structural support of the
vessel wall. Histology has shown that AAA samples contain lymphocytes and
macrophages that may initiate protease activation through various cytokines, including
interleukin (IL)-1, IL-6, IL-8, and tumor necrosis factor (TNF) - α [20]. Circulating IL-6
has been shown to be a cardiovascular risk factor. Secretion of IL-6 increases with aortic
diameter, which may play a role in inflammation or thrombosis [21], further exacerbating
the development of the AAA.

2.2.3. Blood cells and Platelets
The characteristics of blood flow are dictated by the components of the blood.
Erythrocytes account for nearly half of the blood volume, and are responsible for most of
the viscous and elastic properties of blood [22]. The erythrocytes can flow over each
other with shear dependent rotational motion. This is a result of the parabolic velocity
profile of the flowing blood, as well as the geometry of the red blood cells. This can mix
the blood, leading to displacement of proteins and small cells.
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2.2.4. Normal Physiological Values
Blood can be modeled as a Newtonian fluid in vessels with a diameter greater than 0.5
mm. A number of boundary conditions exist for the velocity vector. First, there is no slip
at the walls (velocity of the fluid at the wall is zero). Second, the velocity profile is
symmetric about the centerline of the vessel. Third, the velocity profile is a fully
developed parabolic profile at the inlet. Lastly, there is a zero-traction outflow condition
at the exit. The molecular viscosity (μ) of blood can approximated as μ=0.00319 Pa·s,
and the density (ρ) can be approximated as 1.050 kg/m3 [3].

2.2.5. Blood Flow
Blood flow throughout the majority of the vasculature is laminar, meaning that the
viscous forces overpower the relative momentum differences between adjacent layers of
fluid [22]. Disturbances between fluid layers are prevented, and a smooth velocity profile
is created across the vessel. Blood flow can be considered steady for Reynolds numbers
within the range 10 ≤ Re ≤ 2265 [3].

2.2.6. Wall Shear Stress and Blood flow
Pressure is created by contractions of the heart, producing hydrostatic force within the
blood vessels. Shear stress is thought to only affect the endothelial monolayer, the inner
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surface of the vessel [23]. Blood flow over the endothelium exerts a wall shear force (τw),
which is a frictional drag force per unit area along the wall. τw is related to wall shear
stress (γw) through the fluid viscosity (μ) shown in Equation 1 [22].

Equation 1:

𝜏! = 𝛾! 𝜇

The wall shear stress in Equation 1 describes the velocity gradient, and can be rewritten
as seen in Equation 2. Here μ is the kinetic viscosity, u is the fluid velocity, y is the
distance from the surface, and du/dr is the velocity gradient (shear rate γ) [24]. γw values
typically range from 10 to 50 dyne/cm2 for arterial flow [22].

Equation 2:

𝜏_!" = −𝜇

!"
!"

Blood typically flows through the vessels with a parabolic velocity field (Figure 3). The
blood accelerates as it passes through a decreased vessel diameter, as a result of
thrombosis or stenosis. This results in higher γw values in the region of reduced diameter.
As the blood passes the region of reduced diameter and reenters the original vessel
diameter, the fluid layers separate, allowing formation of stagnation zones and regions of
recirculation.
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Figure 3. Velocity field of blood flow within an artery

As the fluid exits the area of stenosis, the streamlines do not follow the contour of the
vessel, causing flow separation. This can result in regions of low shear stress near the
vessel wall, and increase the time that the fluid resides near a specific area. In the areas of
stagnation and recirculation, the fluid shearing forces are not great enough to overcome
cell-cell interaction forces. Interactions between leukocytes, erythrocytes, and platelets
occur at low shear stresses, and are known to increase blood viscosity [22]. The viscosity
of blood depends on shear rate. Blood viscosity is affected by changes to shear rate at low
levels of hematocrit. However, as the level of hematocrit increases, the shear rate effect
on the change in blood viscosity becomes greater. In areas of high shear rate (~300 s-1),
for example the aorta, blood viscosity is approximately 3.5 cP, while in vessels with
lower shear rates (~5 s-1), as in veins, the blood viscosity is higher (~10 cP) [24].

The velocity of the fluid is zero at the vessel wall, and reaches a maximum at the center
of the vessel. Assuming the blood vessel is a straight, cylindrical tube with rigid walls,
the shear rate can be found using Equation 3.

Equation 3:

𝛾_!" =

!!
!
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Here, u is the average velocity, Q is the mean volumetric flow, and d is the vessel
diameter [24].
For blood flow within a vessel, the shear stress is defined by the Hagen-Poisseuille
equation, where Q is the mean volumetric flow rate, u is the mean velocity, and d is the
vessel diameter. Equation 4 states that shear stress is directly proportional to blood
velocity, and inversely proportional to vessel diameter [24]. Equation 5 is a variation of
Equation 4, stating that shear stress is directly proportional to flow rate, and inversely
proportional to vessel diameter.

!

Equation 4:

𝜏_!" = 8 𝜇

Equation 5:

𝜏_!" = 32 𝜇

!

!
!∗! !

The Haagen-Poisseuille equation is applied under four assumptions. First, the blood is
considered a Newtonian fluid. Second, the vessel cross sectional area is cylindrical.
Third, the vessel is straight with inelastic walls. Fourth, the flow is steady and laminar
[24].

Normal shear stresses at the walls of an artery have been demonstrated to exist between
10 – 70 dynes/cm2 [24]. Shear stresses in this range stabilize blood vessels and promote
healthy remodeling following an injury [23]. Higher values have been detected in regions
12

of vasculature with turbulent flow, or increased flow velocity, including arteries with
extreme curvature (i.e aortic arch and bifurcations) (Figure 4) [23]. Low shear stress
causes the vessel diameter to decrease, and leads to a mean shear stress level around 15
dynes/cm2. Low shear stress is typically in regions of unstable blood flow, including
those of recirculation and stagnation [24].
High shear stress can be found in laminar flow, and is known to promote endothelial cell
survival and quiescence, alignment in the direction of flow, and secretion of substances

Figure 4. Bifurcation in an artery and the resulting regions of high shear stress and low shear stress.

promoting vasodilation and anticoagulation. Low shear stresses or reversing shear
stresses, as those found in turbulent flow, promote endothelial proliferation and
apoptosis, shape change, and secretion of substances that promote vasoconstriction,
coagulation, and platelet aggregation [23]. Long-term changes in the signaling and
structure of the vessel through shear stress can alter regulation of protein synthesis and
gene expression, which can lead to changes in the vessel wall. These changes can include
the proliferation and migration of SMCs and expression of endothelial cell-surface
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molecules that stimulate leukocyte adhesion and migration [23]. These changes can cause
a weakening of the vessel wall, agitating the effects of an aneurysm.

One method to determine the velocity gradient is to consider the change in linear velocity
between two points on the vessel’s diameter. The shear rate can be determined from
Equation 6:

Equation 6:

𝛾̇ _!" =

∆!
∆!

However, shear rates calculated using this equation are overestimated by anywhere
between 10-45%. A potential cause for this is the inability for accurate arterial wall
tracking [24]. While these estimates may not be perfect, they give an idea of the shear
rate within the artery. It is important to determine the shear rate and shear stresses inside
the artery to understand how the aneurysm is progressing.

2.2.7. Shear Stress Physiology
It is known that turbulent flow leads to complex changes in shear stress magnitude and
direction. There are a number of factors and forces that affect the endothelial cell.
Chemical forces may be autocrine, paracrine, or endocrine. Physical forces can be from
pressure, strain, or shear stress. (Figure 5). The magnitude of shear stress on the
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Figure 6. Shear stress acting on
endothelial cells

Figure 5. Chemical forces acting on
endothelial cells

endothelium (SS) is proportional to Q (volumetric flow rate) of fluid flow in the vessel,
inversely proportional to r (the radius of the blood vessel) (Figure 6) [23].

Shear stress values within a normal physiological range can stimulate endothelial cells to
release factors that regulate the coagulation pathway. Coagulation plays a role in the
growth of aneurysms. These factors include prostacyclin, nitric oxide (NO), calcium,
thrombomodulin, tissue plasminogen activator (tPA), and plasminogen activator inhibitor
type-I (PAI-1). Normal shear stress stimulates endothelial cells to release antithrombotic

Figure 7. Effect of high and low shear stress on the signaling factors of the endothelium

agents, including prostacyclin, nitric oxide (NO), calcium, and thrombomodulin.
Thrombomodulin is the major anticoagulant cofactor, and is up-regulated by high shear
stress [19].
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Shear stress can affect the binding of leukocytes. Leukocyte binding and chemoattractant
expression of endothelial cells are inhibited at high levels of shear stress, while low shear
stresses stimulate leukocyte binding. The phenotype of endothelial cells is dependent on
the hemodynamic environment; high shear stress environments encourage quiescent cells,
activated cells are found in environments of low shear stress (Figure 7) [23].

Blood vessels are under constant mechanical loading, coming from blood pressure and
flow, which causes endothelial shear stress and circumferential wall stress, respectively
[19]. Shear stress plays a role in vasodilation. Nitric oxide (NO) generated from
endothelial NO synthase (eNOS) mediates the response to shear stress [19]. Elevated
blood pressure leads to increased pressure on the vessel wall, which induces vascular
remodeling. This remodeling leads to increased wall thickness, which results in increased
small vessel resistance, and increased large vessel compliance. [19].

The magnitude and direction of blood flow, as well as the activity of nicotinamide
adenine dinucleotide phosphate (NADPH) oxidase affect flow-mediated dilation of the
vessels. Shear stress caused by the blood flow activates a number of different pathways
through the endothelial surface molecules, including platelet endothelial cell adhesion
molecule (PECAM-1), integrins, ion channels, and tyrosine kinase receptors. Shear stress
results in inactivation of vascular NADPH oxidase and reduced superoxide production.
Tension and deformation of the endothelium can also activate integrins, which are
important for shear-induced vasodilation. Shear stress-induced endothelium integrin
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activation can further stimulate phosphorylation of eNOS. This results in activated eNOS
and increased NO production, leading to further vasodilation of the artery [19].

2.2.8. Low Shear Stress
At low shear conditions, plasma proteins allow for the formation of cell-cell bridges,
which change the motion and velocity of the cells. Rouleaux formation is one of the bestknown examples in which erythrocytes aggregate, resembling a 2-dimensional stacking
of coins. However, erythrocytes may combine to form more complex 3D clumps,
increasing the local blood viscosity. The increased viscosity results in decreased blood
flow, and therefore, reduced shear rates [22]. The apparent viscosity of blood increases in
a non-Newtonian manner as the shear rates decrease below 100s-1. These low shear
conditions can promote other cell-cell interactions involving platelets, leukocytes, and red
cells. Goel and Diamond demonstrated that at shear rates below 100s-1, there exist
receptor-ligand interactions that regulate the association of red cells with platelets and
neutrophils. Flow resistance can be further increased during inflammation by leukocyte
adhesion to the vessel wall, as well as leukocyte-red cell interactions [22]. Low shear
stress can contribute to the initiation of atherosclerosis, particularly at the vessel wall.
Low shear stress contributes to a high inflammatory and a high prothrombotic state [19].

Under normal conditions, healthy endothelium exposed to physiological shear stresses
serves as a nonthrombogenic, atheroprotective surface. It regulates functions including
vasomotor tone, as well as long-term vessel remodeling through responding to local
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physical forces. The endothelial cells align and elongate in the direction of flow, and
stimulate increased levels of cyclooxygenase-2, prostaglandin I2, Nitric Oxide (NO), and
antioxidants. In oscillatory or reversed shear stress regions, such as those at bifurcations
in a vessel, low arterial wall shear stresses (<4 dyne/cm2) are associated with expression
of nuclear factor B-regulated genes. Expression of these genes leads to inflammation, as
well as leukocyte recruitment and extravasation [22].

2.2.9. High Shear Stress
Rupture of an AAA occurs when the mechanical stress on the walls exceeds the strength
of the wall tissue. It is important to understand where the regions of high shear stress in
the vessel are located in order to help prevent this rupture. Raghavan et al conducted a
study to determine the peak wall stress, as well as the failure strength, on aneurysmal and
nonaneurysmal aortas. The group found that AAA volume, not diameter, was a better
indicator of high wall stresses, and could potentially help predict AAA rupture [25].
Figure 8 shows the correlation coefficient of the AAA diameter, height, volume, and
systolic pressure. The group concluded that AAA volume has the greatest effect on peak
wall shear stress. The peak wall stress for a nonaneurysmal aorta was found to be 9
N/cm2. The peak wall stress for a 4-cm AAA and an 8-cm AAA was found to be 23
N/cm2 and 45 N/cm2, respectively. Mechanical testing of healthy and aneurysmal
abdominal aortic wall samples showed a failure strength of the nonaneurysmal aorta of
121 N/cm2, while the failure strength of an aneurysmal aorta was 65 N/cm2. AAA rupture
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may occur during the growth of the aneurysm, when the increasing wall stress exceeds
the decreasing failure strength of the aortic tissue [25].

Figure 8. The correlation coefficients of clinically measurable factors
with peak wall stress on the 6 AAAs.

Peak wall stress on the AAAs studied was anywhere between 45% to 69% of their failure
strength. Peak wall stress of the nonaneurysmal aorta was less than 10% of its failure
strength. The location of the peak wall stress in all AAAs was the posterior surface. The
site of maximum stress is also likely to be the site of rupture. Darling et al examined
autopsies of 118 patients with ruptured AAAs. In 82% of all cases, the rupture was
located on the posterior surface [25].

2.2.10. Reynolds Number and the Effect on Blood Flow
The Reynolds number is a dimensionless quantity used to determine the transition
between steady flow and turbulent flow. It is the ratio between the inertial forces and
viscous forces within the liquid. This relationship can be seen in Equation 7
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Equation 7:

𝑅𝑒 =

!"#
!

In this equation, ρ is the density of the fluid, 𝑣 is the average fluid velocity, D is the inner
diameter of the pipe through which the fluid is flowing, and µ is the viscosity of the fluid.

Figure 9. Streamlines for laminar steady flow at (a) Re = 10; (b)
Re = 100; (c) Re = 500; (d) Re = 1000; (e) Re = 1750; and (f) Re =
2265: The direction of the flow is from left to right [3 P].

For fully developed flow, a Reynolds number below 2000 designates laminar flow. A
Reynolds number above 4000 signifies turbulent flow. A Reynolds number between 2000
and 4000 describes transitional flow.
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Figure 9 shows the laminar flow streamline associated with various Reynolds number
values within the range of 10≤ Re ≤ 2265. At Re = 10, given a blood flow rate of 0.12
L/min, there is no flow separation, and the main stream of fluid fills the arterial
distensions. Flow separation begins at a Reynolds number in the range of Re=25. Figure
9 (b) through (f) show inner streamlines that are unaffected by the dilations, as well as
regions of flow recirculation and stagnation. At Reynolds numbers above 500, the reverse
flow occupies most of the volume of the aneurysm sac. The upper region of the aneurysm
sac is slowly moving fluid particles that are basically stagnant. These have high distal and
low proximal shear values. Finol et al observed that as the Reynolds number increased,
the center of the recirculating flow regions moves downstream, as well as closer to the
main stream. This displaced the boundary layer separation points further upstream, and

Figure 10. Pressure distribution along the wall of the double-aneurysm model for selected
Reynolds numbers.

the reattachment points further downstream. This displacement leads to an increased
volume occupied by the stagnation zones within the aneurysm sacs [3].
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Figure 10 shows the distribution of wall pressure throughout the aneurysm model,
relative to the exit pressure of 0 Pa [3]. At this stagnation zone, the wall pressure peaks,
then decreases at the distal end of the aneurysm [3]. This peak in pressure applies stress
to the artery wall, playing a role in the dilation of the artery and promoting aneurysm

Figure 11. Wall pressure, wall shear stress, and streamlines for Re = 2000

formation. Figure 11 displays the relationship between wall pressure and shear stress at
Re=2000 [3]. It can be seen that in the stagnation zones, there is a relationship between
the wall shear stress and the wall pressure. When the pressure increases, the shear stress
also increases. These factors create an environment in which the artery wall dilates, and
the aneurysm can progress.
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2.3.

Dimensions

The abdominal aorta is the large vessel from the heart that travels through the middle of
the abdomen and bifurcates into two arteries supplying the legs with blood [1]. The
human aorta measures 75 cm from the aortic valve to the iliac bifurcation. Along this
path, the aorta distributes oxygenated blood to all other minor arteries, apart from those
of the lungs. The aorta supplies the heart through coronary arteries, the brain through
supra-aortic vessels, and the organs of the abdomen through the abdominal aorta. The
normal diameter of the infrarenal aorta in a population over 50 years old is 1.5 cm in
women and 1.7 cm in men. AAAs are defined as an aortic diameter at 150% of the
normal diameter at the level of the renal arteries [2]. An infrarenal aorta that is over 3 cm
in diameter is considered an aneurysm, even if asymptomatic [20].

One of the strongest predictors of the risk of aneurysm rupture is the aneurysm size. This
risk greatly increases once the diameter reaches 5.5 cm. The Joint Council of the
American Association for Vascular Surgery and Society for Vascular Surgery estimated
the annual rupture risk based on AAA diameter as the following [2]:
1. Less than 4.0 cm in diameter – 0%
2. 4.0 cm to 4.9 cm in diameter – 0.5% to 5%
3. 5.0 cm to 5.9 cm in diameter – 3% to 15%
4. 6.0 cm to 6.9 cm in diameter – 10% to 20%
5. 7.0 cm to 7.9 cm in diameter – 20% to 40%
6. 8.0 cm in diameter or greater – 30% to 50%
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2.4.

Characteristics of Blood

Blood is an assortment of cells, proteins, lipoproteins, and ions. This mixture is
responsible for transporting nutrients and waste throughout the body. Red blood cells
(RBCs) account for roughly 40% of blood by volume [2]. RBCs affect the viscosity of
the blood as well as its behavior. The viscosity of blood is not constant at all flow rates,

Figure 12: Pressure and velocity pulse waveforms in the aorta and arterial branches of a
dog. The pressure maximum becomes amplified while the velocity maximum decreases as
the blood moves downstream.

and can display non-Newtonian behavior at various shear rates. This non-Newtonian
behavior is most clearly observed at low shear rates as the RBCs clump together. Blood is
ejected when the heart contracts during systole, and does not pump when the heart rests
during diastole. The role of the aorta is that of a compliance chamber providing a
reservoir of high pressure during diastole and systole. Pressure and flow have a pulsatile
pattern, as shown in Figure 12 [1].
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2.5.

Pathophysiology and Etiology

The US National Heart, Lung, and Blood Institute identified a number of mechanisms
through which AAAs arise including proteolytic degradation of aortic wall connective
tissue, inflammation and immune responses, biomechanical wall stress, and molecular
genetics [20]. AAAs occur as a result of a breakdown of the structural proteins that
support the aorta, including elastin and collagen. The cause is unknown, although genetic
predisposition is a factor. AAAs arise as a result of deterioration of the media, although
all layers of the tissue are distended. This distension leads to widening of the vessel
lumen and loss of structural integrity [20].

Approximately 90% of AAAs are infrarenal, which could be a result of a number of
factors. There is a decrease in the number of medial elastin layers from the proximal
thoracic aorta to the infrarenal aorta, along with thinning of the media and thickening of
the intima [20]. Thinning of the media results in reduced levels of elastin and collagen.
This decrease in the number of medial elastin layers could be due to the decrease of the
diameter of the aorta from the thoracic region to the abdominal and infrarenal regions [7].

2.6.

Symptoms

Abdominal aneurysms are particularly dangerous because they can often progress without
symptoms. However, in more severe aneurysm cases, some of the symptoms that may be
present include a throbbing feeling in the abdomen, and pain in the back or the side of
your abdomen that can last for days. If the AAA ruptures, symptoms can include sudden
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pain in the lower abdomen and back, nausea and vomiting, constipation and problems
with urination, clammy or sweaty skin, light-headedness, and an elevated heart rate when
standing up [26].

2.7.

Diagnosis

A healthcare provider can examine the abdomen, and feel the pulses in the legs. Based on
these tests, the provider may find a lump in the abdomen, a pulsating sensation in the
abdomen, a second or echoed heartbeat in the abdomen, or a stiff or rigid abdomen [27].
For more definitive results, a number of diagnostic procedures are used to diagnose the
AAA. The first is ultrasound and echocardiography. These tests use sound waves to
create images of the structures inside the body, and can show the size of the aortic
aneurysm [28]. A Computed Tomography (CT) scan uses x-rays to create clear images of
organs. Dye is injected into the arm, making the arteries visible on the CT scan pictures.
This test can show the size and shape of the aneurysm. These pictures are more detailed
than those using ultrasound or echocardiography [28]. Magnetic Resonance Imaging
(MRI) uses magnets and radio waves to create images of the organs and structures of the
body. MRI can precisely detect the size and exact location of the aneurysm [28].
Angiography uses a dye and x-rays to show the insides of the arteries. The function of
this test is to display the amount of damage and blockage in the blood vessels.
Angiography shows the location and size of the aneurysm [28].
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2.8.

Treatment

Endovascular aneurysm repair (EVAR) is used to help repair and reverse the aneurysm.
The two most common treatments for the AAA are interventional repair and surgical
repair. Interventional repair is a minimally invasive procedure using imaging techniques.
An incision is made in the groin, into which a catheter containing a compressed stent
graft is passed into the femoral artery. The catheter is then guided to the AAA, and
opened when in the proper position, creating new walls through which the blood flows
[29]. There are advantages and disadvantages to this interventional repair. The
advantages include no abdominal surgical incision, minimal sutures, faster recovery time,
no general anesthesia in some cases, less pain, and reduced complications [29]. The
disadvantages include possible migration of the graft following treatment, allowing blood
flow into the aneurysm, and a life-time requirement for follow-up studies to verify that
the stent graft is continuing to function [29]. Surgical repair is the most common
treatment for large, unruptured aneurysms. This procedure involves an incision from just
below the breastbone to the top of the pubic bone. The aorta is clamped off, and the
aneurysm is then cut open. A graft is sewn in place to act as a bridge for the blood flow.
The blood then flows through the graft, and no longer allows the pressure from the blood
to further distend the aorta wall [29].

Fatality associated with elective surgical repair was found to be ~5% in one study [21].
The population-based study from the Mayo clinic reported a 5-year survival of 60% after
the repair of AAAs with a diameter greater than 5 cm. A study in Berkshire, showed that
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the 5-year survival rate of patients who underwent surveillance of AAAs less than 4 cm
and 4.5-5.0 cm in diameter was 62% and 45%, respectively [21].

2.9.

General Approach

In this thesis, I will discuss my approach to creating a model of the AAA, and my results
from the study. In Section 1, I discuss the goals for this project. In Section 2, I will give
background information about aneurysm formation relating to shear stress and blood
flow, as well as current methods for detection and treatment of aneurysms. In Section 3, I
will discuss the manufacturing approach for making the vascular construct. Section 4
shows the experimental set up for the flow visualization experiments. Section 5 discusses
the results of the flow visualization experiments, as well as the relevant statistical
analysis. In Section 6, the developed protocol is discussed, as well as future iterations of
this project.
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CHAPTER 3: MATERIALS AND METHODS

3.1.

CAD

The Computer Aided Design (CAD) model was created following the directions in
Appendix A. The Digital Imaging and Communications in Medicine (DICOM) file used
to create the aneurysm model was found online on the OsiriX website [30]. OsiriX is a
software used to view and manipulate DICOM images. The file chosen was titled
“Panaoramix”. This file was an abdominal CT angiogram acquired on a 16-detector
scanner in a patient with an AAA. The DICOM image was imported into OsiriX Lite.
The threshold was adjusted so that the aneurysm had the greatest visibility. A
segmentation was created for bone, so it could be selected and removed from the image.
A segmentation was created for the blood vessels. The remaining information in the file
is all the blood vessels branching from the abdominal aorta. All extraneous vessels along
the abdominal aorta were removed, leaving only the abdominal aorta, the renal arteries,
and the bifurcation of the aorta towards the iliac arteries. The file was then saved as a
stereolithography (STL) file to be manipulated in Autodesk Meshmixer.

Autodesk Meshmixer is software used to edit STL files. The protocol for editing the
aneurysm model can be found in Appendix B. The STL file edited in OsiriX Lite was
imported into Autodesk Meshmixer. The object was made solid, and the edges were
smoothed. Unnecessary edges and bumps were removed from the model, and the edges
were smoothed again. This removed overlapping faces. The aneurysm model was then
saved as an STL file.
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The STL was exported from Meshmixer, then imported into Solidworks, following
Appendix C. The STL file was imported into Solidworks as a solid body. Import
Diagnostics were run on the part to detect any faulty faces or gaps in the geometry. A
new reference plane was created parallel to the front plane above the top of the neck of
the aneurysm. A rectangle was sketched, and used to make an extruded cut. The
aneurysm model was cut just below the renal arteries to allow for the flow visualization
trials to focus on the sac of the aneurysm. The process of creating a new reference plane,
and making an extruded cut was repeated for both of the legs of the aneurysm to create a
flat face for use as outlets for the COMSOL Multiphysics® model. The file was saved
again as a STL file.

Meshlab was used to reduce the number of faces in the STL file to allow for quicker
calculations in COMSOL Multiphysics®. A detailed description of this procedure can be
found in Appendix D. The STL file was imported into Meshlab. Quadratic Edge Collapse
Decimation was used to reduce the number of faces in the aneurysm model. The model
was reduced by 50%, where the geometry of the aneurysm remained intact, but
unnecessary faces were removed. The file was then saved as a STL file.

The aneurysm model was scaled to the correct dimensions in Solidworks. A detailed
description of this process can be found in Appendix E. The STL file was imported into
Solidworks as a solid body. Import Diagnostics were run on the model to detect any
faulty faces or gaps in the geometry. The diameter of the neck of the aneurysm was
measured using the Measure tool. The length was 18.17 centimeters, which is 10x larger
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than it should be. The model was scaled by a factor of 1/10 to create a model with the
correct dimensions. The file was then saved as an IGES file to be imported into
COMSOL Multiphysics®.

3.2. Full Vessel Construct

3.2.1. 3D Printing
Fused deposition modeling (FDM) is a manufacturing process that allows for accurate
and rapid modeling of complex parts, which would otherwise require a complicated
manufacturing process. FDM involves taking a computer file, and using a 3D printer to

Figure 13. 3D print of the abdominal aortic aneurysm using PLA.

print the object using the desired material. The aneurysm file was converted from a
DICOM file to a STL file, then processed using a slicer program (Cura) that converts the
model into instructions for the 3D printer (G-code). The code sliced the model into very
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thin layers in the x-y orientation. Polylactic acid (PLA) was heated and extruded from the
nozzle of the printer along the x-y axis in a crisscrossing pattern. Once one level was
completed, the printer raised one increment in the z-direction, and continued to print the
model along that level. This process was continued until the aneurysm was complete.
Support material was required for any overhangs, however this material was removed
from the model after the manufacturing was finished. The build volume for the Printrbot
Simple was 6” x 6” x 6”, with a print speed of 80mm/sec, and a print resolution of 50
microns [31]. The printed model of the AAA can be seen in Figure 13.

3.2.2. Mold
The manufacturing of the mold for the AAA was based on the method of lost wax
casting. This process begins with an object that is to be replicated; in this case we have a
PLA model of the AAA. A mold is made from the object, and the object is removed from
the mold, leaving a hollow chamber in the mold with the same geometries as the original
object. Wax is then poured into this hollow chamber, giving a replica of the original
object. This wax model is then submerged in another material, in our case,
Polydimethylsiloxane (PDMS). The wax is melted from the PDMS, and the final result is
a clear chamber with a hollow region that has the same dimensions and geometries as the
original PLA aneurysm model.
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PDMS was used as the material to create the aneurysm mold. PDMS was chosen because
it is a malleable plastic that is transparent, allowing for easy flow visualization. QUICKSIL RTV Jewelry Molding Rubber was used to create the mold of the AAA. Part A and
Part B were mixed at a 1:1 volume ratio, and spread to encase the 3D printed AAA seen
in Figure 13. Only the entryway to the aneurysm through the aorta was left open. The

Figure 14. The molding rubber was cut from the 3D
printed aneurysm using an X-Acto knife.

molding rubber was allowed to cure for an hour. Once cured, the material was then cut
from the aneurysm into quarters using an X-Acto knife. Notches were made when cutting
the rubber from the PLA aneurysm, so that the rubber mold could be assembled without
the 3D printed aneurysm inside (Figure 14). The PLA aneurysm was removed from the
rubber mold, and the mold was placed back together in one piece. The individual pieces
were held together using rubber bands (Figure 15). Paraffin wax was placed in a
container above boiling water. Once the wax was liquid, a funnel was placed above the
opening to the rubber mold. The paraffin wax was poured into the aneurysm mold, and
then allowed to cool in a freezer. A wooden stick was placed into the top of the wax mold
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and was secured in place as the wax hardened. Once the wax had hardened, the mold was
removed from the freezer, and the rubber bands were removed from the mold. The four
pieces of the rubber mold were peeled from the wax model, taking extreme care around
the legs of the aneurysm, as these were the thinnest and most fragile parts of the mold.

Figure 15. Rubber aneurysm mold with
a hollow chamber into which liquid
paraffin wax was poured.

Figure 16. The acrylic box and the ingredients used to create
the PDMS mold.

Acrylic plastic was used to manufacture the chamber into which the PDMS was poured.
The dimensions of the aneurysm model were 9.8 cm in height, 6.3 cm in width, and 6.6
cm in length. The chamber dimensions were therefore made to be 14 cm in height, 10 cm
in width, and 10 cm in length. The acrylic plastic was cut using a bandsaw. Caulk was
used to seal the corner, ensuring there would be no leaks when the PDMS was poured.

The dimensions of the acrylic box were 10 cm x 10 cm x 14 cm, and the thickness of the
acrylic was 0.5 cm. The available space of the box was 9.5 cm x 10 cm x 13.5 cm. From
these dimensions, the volume of the box was 1282.4 cm3. The volume of the wax
aneurysm model was 100mL. The volume of the PDMS to be used to make the aneurysm
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mold was 1182.5mL. The PDMS consists of two parts, the elastomer base (part A), and
the elastomer curing agent (part B). The mixing ratio of the two parts is 10(A): 1(B).
Rounding up the volume of PDMS used to 1200ml, gives 1100mL of part A and 110mL

Figure 17. Part A and Part B mixed and in the
process of vacuum degassing

Figure 18. The Wax model suspended
in the acrylic box

Figure 19. The Wax model
suspended in the acrylic box

of part B. The acrylic box and items used to create the PDMS mold can be seen in Figure
16. Part A and B were measured into the same container and mixed thoroughly for five
minutes. The container was then placed in a vacuum degasser for two hours to get rid of
the bubbles that appeared from mixing the two parts (Figure 17). The wax model was
suspended above the acrylic box using the wooden skewer (Figure 18 and 19). The
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PDMS was poured into the acrylic box until it reached the top of the aneurysm. The
edges of the acrylic box had not been properly sealed, a portion of the PDMS leaked out.
However, the aneurysm sac was unaffected. The PDMS was allowed to cure for 72 hours.
When the PDMS was completely cured, the mold was removed from the acrylic box. The
aneurysm model can be seen in Figure 20 and 21.

Figure 20. Side view of the wax
inside the PDMS mold

Figure 21. Front view of the wax
inside the PDMS mold

Figure 23. Front view of the
hollow PDMS mold

Figure 22. Side view of the
hollow PDMS mold

The PDMS mold and wax model were placed in boiling water for 30 minutes to remove
the wax from the mold and leave a hollow cavity. The wax was melted from the inside of
the mold, but some adhered to the surface, resulting in a translucent appearance instead of
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a clear appearance. A razor blade was used to scrape of the wax from the surface of the
mold. Gasoline was also used to dissolve the paraffin wax, and allow for easier
removal. The paraffin wax is a non-polar substance due to its chain of hydrocarbons.
Gasoline is a non-polar solvent, and for this reason was used to remove the paraffin wax
from the PDMS mold. The final aneurysm mold used in the flow visualization trials can
be seen in Figures 22 and 23.

3.3. Flow Visualization

3.3.1. Flow Visualization Set Up
In this study, the steady state flow of water was used to simulate the pumping of blood
from the heart. Pulsatile flow was outside the scope of this study. Cardiac output, seen in
Equation 8, was used to estimate the correct pump for flow visualization. In the equation,
CO is the cardiac output in Liters per minute, SV is the stroke volume in Liters per beat,
and HR is the heart rate in beats per minute (bpm)

Equation 8:

𝐶𝑂 = 𝑆𝑉 𝐻𝑅

According to a study from Spodick et al, the average resting heart rate of a human is
between 50 and 90 bpm [32]. The normal stroke volume in the human heart is 70
mL/beat [18]. Cardiac output is given in mL/min, which can be converted to US
Gallons/minute to find a suitable pump.
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Minimum:
CO = (50 beats/min) (70 ml/beat) = 3500 ml/min
3.5 L/min = 55.47 gal/hour
Maximum:
CO = (90 beats/min) (70 ml/beat) = 6300 ml/min
6.3 L/min = 99.86 gal/hour

From these calculations, the suitable rate for the pump must be between 55 and 100
Gallons/hour. To find the flow rate of the pump, tubing was connected, and the time
required to fill 1L was measured for ten trials. The average time was found to be 15.094
± 0.5568 seconds. Equations 9 and 10 were used to find the flow rate of the aneurysm
construct.

Equation 9:

Equation 10:
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The flow rate for the pump was found to be 63.0064 gallons/hour ± 2.33 gallons/hour,
which is in between 55 and 100 gallons/hour. The pump was therefore suitable to use for
the flow visualization trials.
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Tubing with an inner diameter of 5/8” and an outer diameter of 3/4” was press fit into the
neck of the aneurysm model, and tubing with an inner diameter of 3/16” and an outer
diameter of 5/16” was press fit into each of the legs of the aneurysm model. The tubing
was sealed with clear silicone sealant to prevent leaking.

3.4. Imaging Set Up
The aneurysm model and tubing was placed on a bucket, and lighting was placed behind
the PDMS to illuminate the model. An iPhone 6 was placed in front of the model to
capture video of the flow visualization trials. The pump was placed in water, and the
tubing attached to the legs of the aneurysm model was placed in an empty bucket to allow

a.

b.

c.

Figure 24. (a) The tubing connected to the PDMS construct. (b) The set-up of the flow visualization.
(c) The side of the PDMS construct where the videos were taken.

for drainage (Figure 24). The flow rate of the pump was measured at the same position
where the construct would be for the flow visualization trials. It was assumed that the
inlet of the vessel had the same flow rate as the outlet of the tubing. Flow was established
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in the aneurysm model, and the model was inverted to remove any bubbles. Slow motion
video was taken as 1000 mL of red dye was injected into the pump.
Ten trials were administered to measure the time to fill one liter of water measured at the
exit of the PDMS construct. The resulting times were averaged, and a value of 15.094
seconds per Liter was recorded. The flow rate of the pump was determined to be 6.62514
x 10-5 m3/s as seen in Appendix F. Flow rate is conserved throughout the model, so the
flow rate at the exit can be used to find the velocity of the fluid at the entrance of the
model. An average velocity of 26.035 cm/s was determined, resulting in a maximum
velocity of 52.07 cm/s, shown in Appendix F.

3.5. Imaging Methods
The still images collected from the videos of the flow visualization trials were used to
determine the coordinates of the dye as it moved through the aneurysm model. The
coordinates were determined using the following method, and this method was applied to
every image in the trial.
1) Determine an origin (common feature) in COMSOL Multiphysics® and ImageJ
2) Convert pixels to centimeters
3) Find the absolute distance from the origin in x and y coordinates
4) Calculate the velocity between image frames
5) Measure the angle of rotation
6) Apply the coordinate transformation equations to find equivalent coordinates in
COMSOL Multiphysics®
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This method was adapted from a procedure developed by Greinke [16], Willis [17], and
Knauer [18]. The velocity and position of the dye was determined by comparing the
furthest downstream pixel value in one frame to the furthest downstream pixel on the
preceding frame.

Figure 25. Origin of the COMSOL Multiphysics® model (red dot). The
coordinate system of the COMSOL Multiphysics® model is located in
the lower left corner of the graphics window.

The origin was selected where the neck of the aneurysm connects with the sac of the
aneurysm, as this could easily be identified in both the computer model and the physical
model, seen in Figure 25 and 26.

The coordinates were collected in COMSOL Multiphysics® as x, y, and z coordinates.
The origin point was used to align the coordinate systems, and be a reference point for
the physical model.
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Videos of the flow visualization trials were captured. The videos were then converted to
image sequences. The number of frames in the videos was determined, and the number of
frames was divided by the lengths of the videos to find the number of frames per second.
Screenshots of the videos were taken every ten frames, giving a known time difference

Figure 26. The origin of the PDMS construct. The coordinate system is set up
with x=0, y=0 in the lower left corner of the image.

between frames. The images that contained the dye were collected and analyzed using
ImageJ software. A detailed description can be found in Appendix H. The collection of
images was imported into ImageJ, and was merged into a stack. A scale was set using the
length of the PDMS mold (10 cm). This allowed the coordinates in ImageJ to represent
centimeters and not pixels. The point of interest in each image was the location of the red
dye. In ImageJ, a threshold was chosen so that the red dye was more easily visible. The
stack was then converted back into individual images. The location of the furthest dye
point was collected using x and y coordinates. The initial point where the dye entered
neck of the aneurysm was denoted point “a”. In the following frame, the furthest dye
point was denoted point “b”. This was replicated for each frame and subsequent dye point
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until the dye had exited the legs of the aneurysm, culminating at point “h”. The different
trails were denoted by numbers, so point “a” on trial one was denoted “T1a”.

The absolute coordinates were determined by taking the image coordinates and then
subtracting the x and y coordinates from the coordinates of the model origin. The
absolute coordinates represented the distance between the pixel at the front of the dye and
the origin. The absolute coordinates were used to determine the change of position of the
dye front. The absolute coordinates of the preceding image were subtracted from the
absolute coordinates of the image of interest. This change of position was then used to
calculate the velocity of the dye between the two images. The time between the images
was found by taking the total length of the video divided by the time of the video. The
slow motion videos taken on the iPhone 6 were shot at 240 frames per second. The region
of interest where the dye initially entered the aneurysm construct until it left the construct
was 3 seconds long. The video therefore had 720 frames. The time per frame was 3
seconds divided by 720 frames, or 0.00416667 seconds/frame. There were ten frames
between each captured image. The velocity was calculated by dividing the change in
position by the time between each image, (0.00416667*10). The outcome is values of x
and y for the experimental model in terms of absolute coordinates and velocity.

The angle of rotation was determined in order to properly transform the coordinate
system from the ImageJ coordinates into the COMSOL Multiphysics® coordinates. A
detailed description can be found in Appendix I. Screenshots of the COMSOL
Multiphysics® geometry were imported into ImageJ. The angle of the neck of the
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aneurysm and the angle of the legs of the aneurysm were determined using the angle tool.
The image of the PDMS mold was imported into ImageJ. The angle tool was used to
determine the angle of the neck of the aneurysm and the legs of the aneurysm. The angle
of the neck of the PDMS model was subtracted from the angle of the neck of the
COMSOL Multiphysics® model. The result was the difference in angle between the
COMSOL Multiphysics® model and PDMS model. The angle of the legs of the PDMS
model was subtracted from the angle of the legs of the PDMS model. The result was the
difference in angle between the COMSOL Multiphysics® model and the PDMS model.
The difference in angle of the neck and the difference in angle of the legs were averaged,
and the resulting angle was the angle of rotation used in the transformation equation.

To transform the PDMS coordinates to the COMSOL Multiphysics® coordinates, it is
necessary to describe both of the coordinate systems. The coordinate system in ImageJ
has its origin in the lower left corner of the image. The positive x- and positive y-values
are of a standard coordinate system. The y-coordinates in COMSOL Multiphysics® are
the x-coordinates in the ImageJ model. The z-coordinates in COMSOL Multiphysics®
are the y-coordinates in the ImageJ model. The x-coordinates in COMSOL
Multiphysics® are the z-coordinates in the ImageJ model. Whereas in the ImageJ model
the x-coordinates increase to the right, in the COMSOL Multiphysics® model, the ycoordinates increase to the left, as seen in Figures 25 and 26.
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The pixel coordinates were transformed to COMSOL Multiphysics® coordinates using
the coordinate transformation equations adapted from studies by Grienke [16], Willis
[17], and Knauer [18]. The equations can be seen in Equation 11 and 12:

Equation 11:

𝑥!"# =

𝑥 − 𝐶! 𝑐𝑜𝑠𝜃 −

𝑦 − 𝐶! 𝑠𝑖𝑛𝜃

+ 𝐶!

Equation 12:

𝑦!"# =

𝑥 − 𝐶! 𝑠𝑖𝑛𝜃 +

𝑦 − 𝐶! 𝑐𝑜𝑠𝜃

+ 𝐶!

Where xrot and yrot represent coordinates in the COMSOL Multiphysics ® model, x and y
represent the point of interest in the image, Cx and Cy represent the COMSOL
Multiphysics ® origin coordinates, and θ represents the angle of rotation measured from
the experimental model.

The result of the transformation equation were x and y coordinates (COMSOL
Multiphysics® y and z coordinates) that described the farthest moving pixel within the
model. Because the x coordinates in ImageJ increased in value to the right, and the
corresponding COMSOL Multiphysics® y coordinates increased to the left, it was
necessary to invert the ImageJ x coordinates (COMSOL y coordinates). The COMSOL
Multiphysics® y-coordinates were mirrored around the y value at the COMSOL
Multiphysics® origin.
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The outputs of this sequence were x and y coordinates within COMSOL Multiphysics®
that represented the farthest moving pixel within the model, as well as the associated
velocities. These coordinates were then input into the COMSOL Multiphysics® model to
compare velocity measurements

3.6. Velocity Values

The coordinates were input into COMSOL Multiphysics® following the directions seen
in Appendix I. A 3D cut point was added to the COMSOL Multiphysics® model. The x
and y coordinates transformed from the ImageJ coordinate system to the COMSOL
Multiphysics® coordinate system were input into COMSOL Multiphysics® as y- and zcoordinates, respectively. The x-value used as the origin was input as the x-value for each
3D cut point. The 3D cut point was plotted. This process was repeated for all coordinates.
To obtain the velocity at the 3D cut point, a point evaluation was used for each 3D cut
point. The velocity from this approach was the maximum velocity at that point.

3.6.1.

Mesh Confidence Study

To find a COMSOL Multiphysics® mesh that provided accurate velocity values, a mesh
confidence study was performed. The COMSOL Multiphysics® model was amended so
that instead of a turbulent model, a creep flow model was used to model the fluid flow.
This was done to allow for quicker COMSOL Multiphysics® computations. A point
within the COMSOL Multiphysics® model was chosen to evaluate the velocity at

46

different mesh accuracy levels. The point T3b, the second velocity point on third fluid
visualization trial, was selected. The maximum velocity was determined for three mesh
accuracy levels as seen in Table 1.

Table 1: COMSOL Multiphysics Mesh levels and corresponding number of elements

COMSOL Multiphysics Level Number of elements
Normal

62,280

Fine

162,745

Finer

279,287

Table 2. Velocity Values used in the Mesh Confidence Study

The COMSOL Multiphysics® model did not converge for Extra Fine and Finest, so they
were not evaluated. The velocity at two levels were compared, and the process was
completed when there was a difference of less than 5% between two mesh levels as seen
in Tables 1 and 2. The process is detailed in Appendix J. The mesh was used for the
COMSOL Multiphysics® evaluation.
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3.6.2. COMSOL Multiphysics® model
The COMSOL Multiphysics® model was created following the directions in Appendix
K. A 3D component was created. Parameters for the model were input. The density and
viscosity of water were used to replicate the PDMS model. Density (rho) = 1000 kg/m3
and viscosity (vis) = 0.8 cP. Gage pressure was used in the model, so the output pressure
(P_out) = 0 Pa. The flow rate of the pump was used to determine the mass flow rate;
rho*flow rate [6.62514 x 10-5 m3/s *1000kg/m3]. 6.6251 x 10-2 kg/s was input as the
parameter for the inlet. The IGES file of the aneurysm model was imported into
COMSOL Multiphysics®. Laminar flow physics were added to the model. Density and
viscosity were selected as the fluid properties. Under the properties of laminar flow, a
laminar model was selected. The Reynolds number was found using Equation 7.
In this equation, 𝜌=1000 kg/m3, 𝑣=52.07 cm/s, D=1.89 cm, and 𝜇=0.89 cP. Therefore the
Table 3. Percent differences of the velocity values used in the Mesh Confidence Study

Reynolds number is 11,060. From this number, the flow should be represented as
turbulent flow. However, when creating the COMSOL Multiphysics® model, the
aneurysm model was unable to converge using turbulent flow. Laminar flow was chosen
instead of turbulent flow.
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The top of the neck of the aneurysm was chosen as the inlet, and the ends of the legs of
the aneurysm were chosen as the outlets. In the inlet, the boundary condition selected was
velocity. Mass flow rate was input as input parameter. The boundary condition for the
outlets was set to pressure, and P_out was input as the pressure condition. As seen in
Tables 2 and 3, a Fine mesh was chosen for the COMSOL Multiphysics® model. A time
dependent study was added to the model, and the study was computed.

3.6.3. COMSOL Multiphysics® Validation using normal blood vessel

A simplified blood vessel model was created to validate the COMSOL Multiphysics®
results. Fluid velocities and wall shear stresses for a 3D steady state model of an artery
were estimated through COMSOL Multiphysics®, and the results were compared to
theoretical values. The given information for this model can be seen in Table 4.
Table 4. Given information for COMSOL Multiphysics® validation study

The Hagen-Poiseuille equation was used to determine the theoretical pressure drop
between the inlet and outlet, seen in Equation 13. It was assumed that there was no slip
on the walls of the vessel and outet pressure was zero. Here the flow rate Q =
(velocity)(Area), radius R = 2.5mm, velocity v = 30 cm/s, outlet pressure P2 = O Pa,
viscosity µ = 3 cP, and length L = 10 cm. The resulting pressure for the inlet pressure, P1,
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was found to be 115.2 Pa. The theoretical wall shear stress was calculated using Equation
14. Here inlet pressure P1 = 115.2 Pa, outlet pressure P2 = 0 Pa, radius R = 2.5 mm, and
length L = 10 cm. The resulting average shear stress was found to be 1.44 Pa.

Equation 13:

𝑄=

Equation 14:

𝜏! =

!! ! (!! !!! )
!!"

!! !!! !
!!

Table 5. Parameters used in COMSOL Multiphysics® validation
study

A quarter cylinder was created in COMSOL Multiphysics® using the parameters in
Table 5. A symmetry boundary condition was used to simulate a cylindrical artery. The
mesh used in the model was “Finer”, and the mesh statistics can be seen in Appendix L.
Creeping flow was used to model the fluid flow using steady state conditions.
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The resulting velocity slice plot can be seen in Figures 27. To find the average velocity of
the COMSOL Multiphysics® model, a line maximum was selected using the line

Figure 27. Velocity slice plot of artery for COMSOL Multiphysics® validation.

Figure 28. Line maximum used to find the maximum velocity of
the artery fluid model

extending from the center of the vessel to the outer diameter, highlighted blue in Figure
28. The average velocity was found to be 30.059 cm/s, compared to the theoretical value
of 30 cm/s. The percent error in this calculation was 0.1967%.
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A slice plot of the shear stress is shown in Figure 29. To find the average wall shear
stress of the COMSOL Multiphysics® model, a surface average was taken over the
outer wall of the artery, as seen in Figure 30. The average wall shear stress was found to
be 1.4402 Pa, compared to the theoretical wall shear stress of 1.44 Pa found using

Figure 29. Shear stress slice plot of artery for
COMSOL Multiphysics® validation

Figure 30. Surface selected to determine the
average surface shear stress of the artery fluid
model

Equation 15. The percent error in this calculation was 0.0139% error. The goal of this
COMSOL Multiphysics® validation study was to give show that the results given from
the simple artery model are very accurate. This allows the values of the aneurysm model
to be believed to be accurate as well.
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CHAPTER 4: STATISTICAL ANALYSIS

4.1.

Statistical Testing

The statistical analysis comparing the experimental results and the COMSOL
Multiphysics® results was calculated using a Paired 2-Sample t-test using JMP software.
For the study, alpha was set to 0.05, and the confidence interval was set to 95%. The null
hypothesis was that there was no difference between the two samples. The alternative
hypothesis was that there was a significant difference between the samples. The output
seen in Figure 31 shows a p-value of 0.0950, which is greater than 0.05. Since the p-value
of 0.0950 is larger than 0.05, we fail to reject the null hypothesis, as there is not
significant statistical evidence to conclude a difference between the experimental velocity
values and the COMSOL Multiphysics® velocity values.

Figure 31. Paired 2-sample t-test results calculated using JMP software.
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4.2.

Comparative Results

The following four graphs are comparisons between the experimental velocity values and
the COMSOL Multiphysics® velocity values at equivalent coordinate points. Each graph
is specific for the trial that was completed. Point “a” was located in the neck, and
descending through the aneurysm sac to the leg of the aneurysm at point “h”. As
previously mentioned, the experimental velocity values were calculated by measuring the
distance between the furthest downstream dye point in one frame and the furthest
downstream dye point of the preceding frame. This distance was then divided by the time
between the two frames. The resulting value is the velocity of the fluid at the designated
coordinate point.

Figure 32. Scatter plot of Trial 1 comparing the COMSOL Multiphysics®
and experimental velocity values at each coordinate point.

As seen in Figure 32, the velocity values of both the COMSOL Multiphysics® model and
the experimental model follow a similar trend of higher velocities at the neck and the legs
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of the aneurysm, and reduced velocities in the aneurysm sac. The experimental velocity
values also tend to be higher the COMSOL Multiphysics® velocity values.

As seen in Figure 33, Trial 2 follows a similar trend as Trial 1, in that the velocity values
tend to be higher near the neck and the legs of the aneurysm for both the experimental

Figure 33. Scatter plot of Trial 2 comparing the COMSOL Multiphysics®
and experimental velocity values at each coordinate point.

Figure 34. Scatter plot of Trial 3 comparing the COMSOL Multiphysics®
and experimental velocity values at each coordinate point.
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and COMSOL Multiphysics® models. However, there are anomalies that may be due to
inaccuracy in the model. The experimental values again tend to be higher than the
COMSOL Multiphysics® model.

As seen in Figure 34, the difference between the experimental and COMSOL
Multiphysics® velocity values is greater than Trial 1 and 2, however the same trend
exists where the velocities are greater in the neck and legs of the aneurysm, and lower in
the sac of the aneurysm. The experimental velocity values are all greater than the
COMSOL Multiphysics® velocities.

Figure 35. Scatter plot of Trial 4 comparing the COMSOL Multiphysics®
and experimental velocity values at each coordinate point.

As seen in Figure 35, the results are not as distinct as Trials 1,2, and 3. The COMSOL
Multiphysics® velocities follow the same trend as before with a greater velocity in the
neck and legs of the aneurysm, and a reduced velocity in the sac of the aneurysm,
however the experimental values appear more scattered. Again the experimental values
tend to be greater than the COMSOL Multiphysics® values.
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CHAPTER 5: DISCUSSION AND RESULTS

5.1.

Interpretation of Experimental Model

One aspect of this study was to create vasculature with an aneurysm in translucent
polymer for flow visualization. The methods developed in this study used to create a
physical model were effective and met the purpose of the study. It is possible and feasible
to create a model of the abdominal aortic aneurysm from a CT scan. 3D printing was
used to create a cheap but physiologically accurate model of the AAA. The PDMS
construct created from the 3D printed aneurysm model was transparent enough to
complete flow visualization studies, and was not damaged during experimentation.
Another aspect of this study was to make the construct fully three dimensional with no
seams. The aneurysm construct was manufactured using a single pour of PDMS. This
method of manufacturing allowed for a hollow aneurysm chamber in a solid block of
polymer, free from seams that could disrupt the flow of liquid during flow visualization
testing.

This model could be used for the purposes of clinical testing, or for research and
development. One application could be to create a physical model of a patients AAA.
This model could then be used as a training tool for surgeons to practice the deployment
of medical devices such as an endovascular stent graft, or it could be used as a reference
during the surgery to give the surgeon a better idea of the complicated geometry of the
aneurysm. This application would be for the purpose of reducing surgical error. A second
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application would be to use the aneurysm model to analyze a medical device during the
testing and validation phase of development. The model would be able to give a
qualitative analysis of the effect the medical device had on the blood flow within the
aneurysm. A more quantitative analysis can also come from a computer model, and will
be discussed in Section 5.2.

5.2.

Interpretation of COMSOL Multiphysics® Model and comparison study

One of the goals of this study was to perform flow visualization and velocity
characterization for comparison with finite element analysis. By using the velocities
recorded from the PDMS construct, equivalent coordinate points were plotted in
COMSOL Multiphysics®, as previously shown, and these coordinate points were used to
calculate the velocities at each point. Through a 2-Sample t-test, it was found that there
was not evidence of a significant difference between the experimental model velocities
and their equivalent COMSOL Multiphysics® velocities. The velocity results for each
model appear to follow the correct trend of a larger velocity at the neck and the legs of
the aneurysm, where the diameter of the vessel is smaller, and a decreased velocity in the
sac of the aneurysm, where the diameter of the vessel increases. This is due to the
equation of continuity [33].
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There are a number of applications that a computational model can be used for. One
application is to visualize the velocity profile that was seen in the experimental model,

Figure 36. Wall shear stress in Pa for the aneurysm model plotted in
COMSOL Multiphysics®

but with a more quantitative analysis. It is possible to see how the velocity is affected by
the geometry of the aneurysm. In addition to analyzing characteristics that can be viewed
in the experimental model, the computational model allows the user to analyze aspects
that are not evident in the experimental model. Shear stress
and pressure are both extremely important to understanding an aneurysm, and through the

Figure 37. Zoomed in image of the wall
shear stress in the neck of the COMSOL
Multiphysics® aneurysm model
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computational model, it is possible to see how the fluid flow and the geometry of the
aneurysm affect both the wall shear stress as well as the pressure on the wall of the
vessel. In Figure 36, there are regions of high shear stress where the legs of the aneurysm
branch from the sac of the aneurysm, as well as high stress

Figure 38. Zoomed in image of the wall
shear stress in the legs of the COMSOL
Multiphysics® aneurysm model

in where the neck of the aneurysm joins the sac of the aneurysm. There are also regions
of low shear stress in the sac of the aneurysm. Both high and low shear stresses have an
effect on the aneurysm. High shear stress can damage the endothelial cells, negatively
impacting their ability to remodel [34]. Low shear stresses have been reported to be

Figure 39. Plot of the wall pressure in Pa on the
COMSOL Multiphysics® aneurysm model.
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Figure 40. Zoomed in image of the wall
pressure in the legs of the COMSOL
Multiphysics® aneurysm model.

related to aneurysm growth and rupture [34]. Figure 37 and 38 show a zoomed in image
of both high shear stress regions of the aneurysm model. Figure 39 shows the pressure on
the walls of the aneurysm, calculated using COMSOL Multphysics®. It can be seen that
in the neck and the sac of the aneurysm, the pressure is much higher than in the legs of
the aneurysm, which has an impact on the aneurysm. Studies have shown that high
pressure accelerates aneurysm expansion, and has been related to aneurysm rupture [35].
Figure 40 shows a zoomed in image of the pressure in the aneurysm model.

When analyzing the characteristics of the aneurysm model, it is important to be able to
compare them to a healthy aorta. A model was created in COMSOL Multiphysics® to

Figure 41. Wall shear stress values in Pa in a
healthy aorta given the same inlet diameter,
viscosity, density, and mass flow rate as the
aneurysm model.

Figure 42. Pressure in Pa in a healthy aorta
given the same inlet diameter, viscosity,
density, and mass flow rate as the aneurysm
model.

visualize the effect that the aneurysm had on the pressure and the wall shear stress. A
vessel was created that had the same inlet diameter, viscosity, density, and mass flow rate
as the aneurysm model. The outlet diameter was decreased to allow for a tapered vessel
to replica the aorta as it descends through the abdomen before it splits to the iliac arteries.
Figure 41 shows that the values of the wall shear stress are on the same magnitude as the
aneurysm model, which gives confidence that the values calculated from the aneurysm
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model are correct. What is interesting though, for most of the healthy aorta, the wall shear
stress values are less than 1 Pa, where as in the aneurysm model, the wall shear stress
values reach almost 6 Pa in some regions.
Figure 42 shows the values of the wall pressure in the healthy aorta. It can be seen that
the pressure in the inlet matches the pressure in the aneurysm model. Also, the pressure
change is much more gradual in the healthy aorta, as opposed to the aneurysm model
which has high pressure for most of the aneurysm, and only drops in the legs.

The results of this study show that there is not a significant difference between the
velocity values of the experimental model and the velocity values of the model created
using COMSOL Multiphysics®. While the results between the two models differed
slightly, the in silico model validated the computational model. While a physical model is
useful for various reasons previously explained, the computational model uses fewer
resources to create and can output more results from a single study. A computational
model can also be used when validating a medical device, for which physical testing
would not be feasible.

5.3.

FDA use of computational models

The validation of the aneurysm model using COMSOL Multiphysics® makes this
protocol applicable to medical device testing. The Food and Drug Administration (FDA)
is the regulatory body within the United States that is responsible for the approval and
clearance to produce and market medical devices as procedures [36]. Testing is required
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to show the safety and efficacy of a device or procedure, however, the FDA recognizes
computational models as a method of to evaluate this criteria. “Computational Fluid
Dynamics and Mass Transport” is a publicly available document, which provides
guidelines for testing and submission of a computational model [37]. This document
includes information regarding the rationale for choosing the computational modeling
approach as opposed to other approaches. The geometry, material properties,
boundary/initial conditions, the simulation results, the quantities of interest, their
implications for device safety and effectiveness are all included as reasons for using a
computational model. This document does not provide requirements, it provides the
suggestions that the FDA has for developing a thorough protocol for testing a medical
device or procedure. The validation method used in this study was used to statistically
validate a finite element analysis model and could hypothetically meet FDA requirements
for submission.
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CHAPTER 6: SUMMARY AND CONCLUSIONS

6.1.

Contributions to Biomedical Engineering

The results of this study contributed to the field of biomedical engineering by developing
a method for creating a three-dimensional physical model of a CT scan, further
establishing a novel technique for flow visualization, and successfully performing in
silico validation. This model can be used both in a clinical and a research setting. The
protocol described in this study could be applied to many different geometries to create
complex physiological models, and since it was performed on a budget of less than $400,
it is a feasible form of validation testing. This study utilized a method of flow
visualization developed in three previous studies. By further developing the method,
three of the four studies have successfully used this method of flow to validate a
computational model.

6.2

Study limitations

While the study was successful, there were a number of limitations associated with both
the physical model and the computer model. In the physical model, a limitation was that
there were ridges present in the 3D model due to the step sizes in the 3D printing. While
these ridges were small, and may have had a small effect on the resulting flow during the
flow visualization study, there were still present. Another limitation in the physical model
was that the pressure was not controlled at the inlet and outlet. The outlet pressure in this
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study was atmospheric. Since the aneurysm construct was made of PDMS, the pressure
inside the aneurysm increased as the fluid flowed through it, causing PDMS to distend,
resulting in an increase in the flow rate. When measuring the time to fill 1L using the
tubing that connected to the inlet, the flow rate was found to be 7.7095 x 10-5 m3/s
however when measuring the time to fill 1L at the outlet after the fluid flowed through
the construct, the flow rate was found to be 6.62514 x 10-5 m3/s. The flow rate should be
the same at the inlet and the outlet, so there is an issue with the model.

A limitation in the computer model was that the flow visualization study took a twodimension video and tried to apply the coordinates to a three-dimensional coordinate
system. The z-coordinates in the COMSOL Multiphysics® model were estimated to be
the center of the flow profile, as this would be where the highest velocity was. Another
limitation of the computer model was that COMSOL Multiphysics® required a
simplification of the original geometry to be able to process the file size. The mesh size
used had the highest number of elements possible, as finer meshes caused the simulation
to fail. The study was also run using laminar flow even though the characteristics called
for turbulent flow. The simulation was unable to be completed using a turbulent flow, so
laminar flow was chosen.

For the overall study, the limitations were associated with simulating in vivo conditions.
Pulsatile flow would better mimic blood flow within the body, but was outside the scope
of this study. Blood, or fluid with similar properties, would better emulate physiological
condition for testing, but was also outside the scope of this project. The geometry used in
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this study was a simplified model of real patient anatomy. An assumption in this model
was that the simplification of the model maintained the significant characteristics of the
anatomical features.

There were a number of possible sources of error during this project. First, there was
error when performing the flow rate calculations. An error of ±0.5568 seconds was
calculated. While this was a small amount of error, it is possible that it compounded
through the number of steps required to determine the COMSOL coordinates. Another
source of error was when the threshold was applied to the image sequence in ImageJ. The
threshold was applied manually, so there was human error involved in this process.
Following the threshold step, the furthest dye point in each of the image sequences was
located manually. This error could have been amplified at the entrance of the aneurysm.
It is possible that the error at the inlet of the aneurysm causes a greater error for velocity
calculations, as the points are closer together. By estimating the location of the furthest
dye point, being off by a few pixels causes greater error than for images where the dye
front is further apart, as is the case for the dye points in the sac and legs of the aneurysm.
Another source of error was in the pump that was used. The flow rate was affected by the
backflow of the water. This allowed for an inconsistent flow rate during the flow
visualization trials. The last source of error was in the coordinate transformation. The
coordinate transformation was accurate at most points, however, a number of coordinate
points were not accurately transformed and ended up near the vessel wall, giving an
artificially low velocity value
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6.3

Future Works and Conclusions

Minimally invasive surgeries are the most recent development to treat the complications
of cardiovascular disease. Relevant applications include transcatheter aortic valve
replacement (TAVR) and endovascular aneurysm repair (EVAR). As these procedures
progress, it will become increasingly important to evaluate the medical devices, and
visualize how they affect blood flow within the region of interest. This study provides the
basis for developing a cheap and reusable, but physiologically accurate model to analyze
blood flow.

In future studies, fluid with physiologically accurate properties should be incorporated.
Water, which is a Newtonian fluid, was used in this study, however to properly model the
in vivo characteristics, blood, which is a non-Newtonian fluid, should be used. This
would be necessary when using this protocol for medical device testing. Within the
physical model, the model could be extended to incorporate medical devices to visualize
how the device affects the blood flow. This could be used both as practice for the
surgeons implanting the medical devices in complicated geometries, as well as used for
research and development purposes to verify that there are no adverse effects of the
medical device.

In conclusion, this study used a CT scan to create an anatomically accurate physical
model of an abdominal aortic aneurysm, as well as a computational model of the same
aneurysm. The computational model was successfully validated using a novel method of
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flow visualization. The validation of the computational model is applicable to EVAR
procedures, and this method could be applicable for different anatomies and other
procedures within the aorta.
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APPENDICES

Appendix A: DICOM to STL

Based off a tutorial found at https://vimeo.com/101017010

1. Import DICOM images into Osirix

72

2. Adjust toolbar options to obtain proper tools are present
a. Format > Customize Toolbars

73

3. Select group of images to adjust window threshold level. Select the icon and
move the mouse up and down to find the optimal range

74

4. Select the bone using the ROI tool so that we can remove it from the data.
a. ROI > Grow Region (2D/3D Segmentation)…
b. Select “3D growing region”
c. Select for algorithm “Threshold lower/upper bounds”
d. Lower threshold: 200
e. Upper threshold: 3000
f. Select the section of bone from the images by clicking the bone, then
clicking compute

75

5. Fill and expand selection. Fill with black pixels, to make it disappear
a. ROI > Brush ROI > Dilation
i. Set Structuring Element Radius to 5 pixels

76

6. Fill in the selected ROI so that the pixel values can be set to black, making the
bone ROI disappear
a. ROI > Set pixel values to…
b. Set all pixels inside the selected ROI to -3000 (black)

77

7. Adjust the images so that the 3D rendering forms an enclosed surface.
a. Create a rectangle that covers the entire image on the first and last image
of the series.
b. Set the pixel values to -3000 using the technique previously described
(ROI > set pixel values to…)

78

8. Create new ROI segmentation for vessels
a. ROI > Grow Region (2D/3D Segmentation)…
b. Set lower threshold to 200
c. Set upper threshold to 1000
d. Rename ROI to “vessels”
e. Compute

79

9. Set all pixel values outside the selected ROI to black
a. ROI > Set pixel values to…
b. Set pixels that are: Outside ROI to -3000 (black)

80

10. Set all pixel values outside the selected ROI to white
a. ROI > Set pixel values to…
b. Set pixels that are: Outside ROI to 3000 (white)

81

11. The 3D surface rendering should contain the isolated AAA information

82

12. Remove all arteries/vessels that are not necessary for flow analysis. I will only
leave the renal arteries. I will also remove the iliac arteries, leaving only the
section that comes directly before.

83

13. The final volume rendering after removing the appropriate arteries should contain
the desired AAA information

84

14. In volume rendering, export the file to a .STL file format to be adjusted in
Meshmixer

85

Appendix B: STL to Solid Body
1. Import .STL file into Autodesk Meshmixer

86

2. Make the object a solid
a. Edit > Make Solid
b. Solid type: Accurate
c. Solid Accuracy and Mesh Density to the maximum
d. Accept

87

3. Select the entire object and smooth the edges
a. Select > Deform > Smooth
b. Smooth type: Cotan

88

4. Remove unnecessary features such as bumps to make the file smoother.
a. Select > Edit > Erase and Fill

89

5. Select the whole object and smooth the surface again
a. Select > Deform > Smooth
b. Smooth type: Cotan

90

6. The final edited file should be a smoothed AAA model:

91

7. Make the object a solid again (this will get rid of overlapping faces)
a. Edit > Make Solid
b. Solid type: Accurate
c. Solid Accuracy and Mesh Density to the maximum
d. Accept

92

8. Export as a .STL binary file format

93

Appendix C: Removing Unnecessary Aspects of AAA Model
1. Open Solidworks.

94

2. Import STL file. Select File type and choose STL files

3. Select options. Import File as a solid body. Chose the units to be centimeters.
Select OK.

4. Open the STL file

95

5. Run Import Diagnostics on the Part

96

6. No faulty faces of gaps remain in the geometry. Select OK

97

7. Right click the front plane, and choose Normal To.

98

8. Create a new plane parallel to the top of the aneurysm model.

99

9. Use the Front Plane as the reference plane, and select the new plane to be above
to model. Select OK.

100

10. Right click on the new plane, and select Normal To

101

11. Create a Rectangle on the new plane. Sketch > Corner Rectangle

102

12. Make an extruded cut using the rectangle. Features > Extruded Cut

13. Cut the aorta just below the renal arteries.

103

14. Repeat this process for both of the legs.

104

Appendix D: Reducing the Number of Faces on AAA Model

1. Open MeshLab
2. Import the STL file

105

3. Select Unify Duplicated Vertices and click OK

106

4. Filters > Remeshing, Simplification, and Reconstruction > Quadratic Edge
Collapse Decimation

107

5. Select the percentage reduction and enter 0.50. Check the following: Preserve
Normal, Preserve Topology, Optimal position of simplified vertices, and Postsimplification cleaning.

6. Select Apply. Notice that the number of vertices is half of what it was before the
operation.

108

7. File > Export Mesh As

8. Save the mesh as a .STL file

109

110

Appendix E: Scaling the AAA Model

1. Import the STL file into Solidworks as a Solid body
2. Run Import Diagnostics

111

3. Measure the length of the top of the neck of the aneurysm. Tools > Measure

4. Click the left most point of the neck of the aneurysm, and then click the right
most point to get the measurement across the neck of the model.

112

5. The model is 10X larger than it should be. Scale the model by a factor of 1/10 to
get the actual size of the model. Insert > Features > Scale

113

6. Scale about the Centroid, select uniform scaling, and enter 0.1 as the scale value.
Select OK.

114

7. The model is now the correct size.

115

8. Save the file as a IGES file to be imported into COMSOL Multiphysics®

116

Appendix F: Velocity Calculations
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Appendix G: Flow Visualization Conversion

1. Import Images to ImageJ
2. Convert individual images to a stack. Image > Stacks > Images to Stack

118

3. Set the scale of the stack to convert from pixels to centimeters. Use the line tool to
measure from the left side of the PDMS mold to the right side of the PDMS mold.
Analyze > Set Scale

119

4. The known distance from the left side to the right side is the 10 cm

5. Edit the Brightness/Contrast of the stacked images. Images > Adjust >
Brightness/Contrast

120

6. Adjust the Minimum and Maximum values to increase the contrast

121

7. Adjust the threshold to allow for better visualization of the dye. Image > Adjust >
Threshold

122

8. Sample the threshold to obtain a relatively appropriate value.

123

9. Adjust the values for hue, saturation, and brightness to most accurately match the
dye front. Select “Stack” to apply the threshold to the entire stack of images.

124

10. Convert the stack back into individual images. Images > Stacks > Stack to Images

125

Appendix H: Angle of Rotation

1. Open Screenshots of the COMSOL Multiphysics® geometry in ImageJ

2. Measure the angle of the neck of the aneurysm using the angle tool

126

3. Measure the angle of the legs of the aneurysm by using the angle tool

4. Import the image of the PDMS mold into ImageJ.
5. Use the angle measurement tool to measure the angle of the neck of the aneurysm

127

6. Use the angle measurement tool to measure the angle of the legs of the aneurysm

7. To find the angle of rotation of the neck of the aneurysm subtract the angle found
from the PDMS mold from the angle found using the COMSOL Multiphysics®
model.

31.45-20.31 = 11.14 degrees

128

8. To find the angle of rotation of the legs of the aneurysm subtract the angle found
from the PDMS mold from the angle found using the COMSOL Multiphysics®
model.

35.65 - 25.90 = 9.75 degrees

9. Find the average between the two angles, and this will be the value of the angle of
rotation used in the transformation equation

(11.14+9.75)/2 = 10.445 degrees

129

Appendix I: Coordinate Conversion

1. Right click Data Sets > Cut Point 3D

130

2. Enter the Label “T1a”. Enter the x, y, and z coordinates associated with the
desired point. Click Plot

131

3. Repeat the previous step for all other points to be evaluated.

4. Right click on Data Sets > Cut Line 3D

132

5. Enter the Label “T1a_line”. Enter the y-coordinate from “T1a” in both of the ycoordinate selections. Enter the z-coordinate from “T1a” in both of the zcoordinates. Enter 200 in the x-coordinate for Point 1 and 210 in the x-coordinate
for Point 2. This will allow the Cut Line to travel the entire x-distance of the
aneurysm.

133

6. Repeat the previous step for all other Line Maximums to be evaluated.

134

7. Right click on Data Sets > Cut Plane

8. Enter the Label “T1a_plane”. Under Planes choose xy-planes. Enter the zcoordinate from “T1a”

9. Repeat the previous step for all other Plane Maximums to be evaluated.

135

10. Right Click on Derived Values > Point Evaluation

136

11. Select Point Evaluation. Under Data Set choose “T1a”. Under Expression choose
“spf.U”. Change Unit to cm/s. Select Evaluate.

12. Repeat the previous step for all other points to be evaluated.

137

13. Right Click on Derived Values > Maximum > Line Maximum

138

14. Select Line Maximum. Under Data Set, choose T1a_line. For Expression, enter
“spf.U”. For Unit, choose cm/s. Click Evaluate.

139

15. Repeat the previous step for all other Line Maximums to be evaluated.

16. Right Click Derived Values > Surface Maximum

140

17. Select Surface Maximum. Under Data Set Select T1a_plane. For Expression,
enter “spf.U”. For Unit, choose cm/s. Click Evaluate.

18. Repeat the previous step for all other Plane Maximums to be evaluated.

141

Appendix J: Mesh Confidence Study

1. Choose point to be evaluated at different Mesh levels (T3b)

2. Evaluate the maximum velocity at that point

3. Compare the velocity at that mesh level with the value at the lower level

4. Stop when there is less than a 5% difference in velocity

142

Appendix K: COMSOL Multiphysics® Setup

1. Open a blank model

2. Right Click Untitled.mph > Add Component > 3D

143

3. Right Click Global Definitions > Parameters

4. Input the following parameters:

144

5. Right click Geometry 1 > Import. Change length unit to cm

145

6. Import .IGS file

146

7. Physics > Add Physics

147

8. Choose Laminar Flow and Add to Component

148

9. Click Fluid Properties. Choose user defined for density and dynamic viscosity.
Enter “rho” for density, and “vis” for dynamic viscosity.

149

10. Right click Laminar Flow > Inlet

150

11. Under Boundary Conditions select Mass Flow. Enter “mdotin” for the normal
mass flow rate. Choose the Inlet as the top of the neck of the aneurysm.

151

12. Right click Laminar Flow > Outlet

152

13. Under Boundary Conditions select Pressure. Enter “P_out”. Select the exit of both
legs of the aneurysm

14. Select Initial Conditions. Under Pressure enter “P_out”.

153

15. Right click Mesh. Select Free Tetrahedral

154

16. Right click on Mesh and select Corner Refinement

155

17. Right click on Mesh and select Boundary Layers

18. Select Size underneath Mesh. Under Calibrate For: Choose General Physics.
Select Fine.

156

19. Select Study > Add Study

20. Under Study, select Stationary, and choose Add Study

157

21. Right clock Study and select Compute

158

Appendix L: Mesh Statistics for COMSOL Multiphysics® validation study
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